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1 AMRS

Overview

The File Menu

The Edit Menu

Parametric Graphs

The Utilities Menu

The Help Menu

References

About AMRS

Help File Updated: Sunday, May 7, 2023.

1.1 Overview

During the past 15 years, roof fall rates have fallen dramatically in US coal mines,
particularly in regions where the roof is weakest.  The remarkable reduction in the
number of roof falls has been accomplished with more effective roof support systems. 
The purpose of this paper is to present a design methodology that builds on and
quantifies the basic roof support concepts that have been successful in the US.  The
methodology starts by defining three modes of roof support, based on the roof strength
relative to the stress level: 

1. Strong roof, where roof bolts mainly provide skin control, 
2. Moderate strength roof, which can be supported by roof bolts alone, and 
3. Weak roof, which needs secondary support like cable bolts.  

Next, a large data base of roof fall histories at a number of mines is used to define the
approximate boundaries of these three regimes, based on the Coal Mine Roof Rating
and the depth of cover.  Finally, guidelines are presented for site-specific design of
support systems within each regime. The computer package Analysis of Roof Support
Systems (AMRS) implements the design methodology.
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2 The File Menu

Description:

Use the File menu option to access various file management operations such as:

Creating New Files

Opening Existing Files

Saving Files

Saving Files under Different Names (Save As)

Setting up the Printer

Printing Files

Print Preview

Browsing Text Files

Exiting the Program

2.1 Creating New Files

Description:

Use the New option to erase the existing dataset (if any) from memory and create a
new (blank) dataset.  All related entries are set to their initial values. 

Notes:

· The program will prompt you whether to save the current file to disk.

2.2 Opening Existing Files

Description:

Use the open option to load a file (dataset) from the disk into program memory.

To use Open:

· Select the Open option from the File menu.  The program displays a listing of
the available files in the current data directory.

· Optionally, select a different drive or directory using the mouse or the cursor
control keys.

· Select or enter a filename.  
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Notes:

· If the file extension is omitted, the default extension will be appended. 
· If the current dataset is not saved, the program will prompt whether to save

changes or not before discarding the current dataset.

2.3 Saving Files

Description:

Use the Save option to save an existing file (dataset) to the drive or directory from
which it was originally loaded.  Any changes that were made since the last time the file
was saved will be saved on the disk.  The filename stays the same and the file remains
in memory.

To use Save:

Select the Save option from the File menu.

Notes:

· If the file has never been saved using the Save As option, choosing Save
automatically displays the Save As dialogue box, which prompts for a filename
before saving it.

2.4 Saving Files under Different Names  (Save As)

Description:

Use the Save As option to save a file and give it a new name.

To use Save As:

· Select the Save As option from the File menu.  The program displays a listing of the
available files in the current data directory.

· Optionally, select a different drive or directory. 
· Select or enter a file name.

Notes:

· If the file exists, the program will prompt whether to overwrite the existing file.
· Saving an unnamed file will default to Save As.
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2.5 Setting Up the Printer

Description:

Use this option to select the Printer to use for printing output and graphics. This printer
becomes the Windows default printer. 

To use this option:

Select the Printer from the drop down list and click on OK. 

2.6 Printing Files

Description:

Use the Print option to print the current dataset (file) from program memory to the
default windows printer.  The default printer may be set using the Setting Up the Printer
menu option. 

Notes:

· The file is send directly to the printer, without preview. Use the Print Preview option
to preview the file and then send it to the printer. 

2.7 Print Preview

Description:

The user may navigate through the Print Preview Window by using the vertical scroll
bar. 

The text in the window can be send directly to the printer, or it can be copied to the
Windows clipboard for use in other applications.

Notes:

· This operation does not send any control characters to the printer. All output is
ASCII text. The text prints in "Courier" or "Courier New" font in size 9. If these fonts
are not available to the printer, then printed text will appear in the default printer font.

· Each printed page is formatted with preset margins as follows:
ό left margin = 1 inch
ό top margin = 1 inch
ό bottom margin = 1 inch
ό right margin = variable
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2.8 Browsing Text Files

Description:

Use the browse option to view a text (ASCII) file in a specified directory.  No editing is
allowed during browsing.

Use the pattern field to specify a file pattern (i.e. *.txt). The file window will be reset to
conform to the specified pattern. The default pattern is *.ARB. More than one patterns
can be applied using “;” as delimiter (e.g. *.txt;*.dxf).

Use the Set Font command button to specify the type and size of font for the displayed
text. These settings are saved in the AMRS.INI file.

Use the cursor control keys to move within the browse window.

2.9 Exiting the Program

Description:

Use the Exit option when ready to exit this program and return to the original
environment. The program will prompt you to save the current file to disk, if not already
saved.
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3 The Input Menu

Description:

Use the Input menu option to access various parameter input/edit forms such as:

Project Description

Project Parameters

3.1 Project Description

Description:

This is an arbitrary 300 character description of the model being generated.  It is a
recommended to make this a fairly detailed description of the specifics of the input file.
This text may be a single line of characters or may contain "carriage return characters".

The user can set the type of units that will be used in the current project. The program is
designed to use two different sets of units:
· ft and lbs
· m and kN

The user can also select the type of steel strength that will be used in the current
project. The program is designed to use either yield strength (grade) that characterizes
roof bolts used in the US or ultimate tensile strength (UTS) that characterizes roof bolts
used in Australia.

3.2 Project Parameters

AMRS uses four basic input parameters to describe the roof rock quality, stress level,
roof span, and roof support density.

Rock quality is described by the Coal Mine Roof Rating (CMRR). The CMRR was
developed in 1994 to quantify geologic descriptions of coal measure rocks into a
single strength rating (Mark and Molinda, 2005). The Coal Mine Roof Rating (CMRR)
measures the structural competence of the roof on a 0-100 scale, with higher values
meaning stronger roof. It can be determined either through underground observation or
from exploratory drill core. Based on more than 25 years of experience, conservative
estimates of the CMRR for typical roof types in different US coalfields have been
prepared (Table 1). These values apply to single rock units.  Where the roof consists of
several units, they are combined to obtain the composite CMRR of the roof structure.  A
computer program that aids in calculating the CMRR from underground or core data
can be obtained at https://www.cdc.gov/niosh/mining/works/coversheet1812.html.
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Table 1.  Estimates of CMRR for typical roof rock in different US coalfields

Rock Type
Coalfield

Northern
Appalachian

Central
Appalachian

Midwest Western US

Claystone 35 40 35 35-40

Shale 40 45 38-40 45

Siltstone 45 50 45 50-55

Sandstone 55 55-65 45 55-65

Limestone 55 50-65

Stress level includes both the vertical load due to weight of the overburden and the
horizontal stress that originates in plate tectonics. Actual in situ stresses are rarely
measured in US coal mines, but the available data clearly indicates that the horizontal
stress increases with depth, though the gradient may vary from coalfield to coalfield
(Mark and Gadde, 2008).  The cover depth (H (ft)) is therefore used as the input for
AMRS. The user should enter the typical depth of cover for an area, not the maximum
beneath a ridge or the minimum beneath a stream valley. In fact, the stresses may
actually be concentrated beneath stream valleys.

Roof span is a third fundamental parameter that affects the stability of underground
structures (Mark and Barczak, 2000).  The entry width is self-explanatory.  For four-way
intersections, ARMS requires the sum-of-the-diagonals (SumD). These are normally
measured underground, or the maximum allowed by the Roof Control Plan may be
used. If no measurements are available, the following are typical values (source: Mark,
2000):

Entry Width (ft) SumD (ft)
16 60
18 64
20 66

If the actual SumD seems too small for the entered We (defined as smaller than 4 feet
plus ((2*We2)0.5)), then the following warning is printed:  “Intersection diagonals and entry
width may not match".

Roof support density captures the load-bearing capacity of the roof support system.  A
number of input parameters are needed to define it, depending on the type of roof
support system that is being analyzed (Figure 11).

Primary Support / Roof Bolts
Lb = Length of the bolts (ft)



ANALYSIS OF MINE ROOF SUPPORT14

Nb = Number of bolts per row,
Gr = Bolt grade (nominal yield strength, ksi) (may be specified through drop down menu
with standard values or manually),
Db = Bolt diameter (inches) (may be specified through drop down menu with standard
values or manually),
Sb = Spacing between rows of bolts (ft)

The Stability Factor is a final input parameter for analysis of primary support.  An AMRS
SF of 1.0 is currently considered appropriately conservative.  Figure 10 shows that the
AMRS suggested PSUP values with SF=1.0 are approximately equivalent to the 2001
ARBS suggested values with an SF=1.5. 

The user can select a standard roof bolt setup with respect to bolt diameter and grade
(Table 2), or they can select any combination diameter and grade combination. 

Table 2.  Standard roof bolt diameters and grades available in the US
US Roof Bolts Diameter (in) Grade (ksi)

#5 smooth - grade 55 0.625 55

#5 rebar - grade 60 0.625 60

#5 smooth - grade 75 0.625 75

#5 special rebar - grade 75 0.677 75

#6 rebar - grade 40 0.75 40

#6 rebar - grade 60 0.75 60

#6 smooth - grade 75 0.75 75

#7 special rebar - grade 75 0.804 75

#7 rebar - grade 40 0.875 40

#7 rebar - grade 60 0.875 60

Secondary Supports
The rock load height is the assumed thickness of the broken roof that needs to be
carried by the total support.  Often the observed height of past roof falls can be used
(see Figure 9).

The roof fall angles, relative to vertical, will also significantly impact the volume of
immediate roof. For example, a roof fall with vertical shear planes on each side will
result in loads 1.5 to 2.0 times larger than a similar fall with a 45-degree fall angle. In
general, the weaker the roof the steeper the roof fall angle. Typical roof fall angles are
shown in Table 3 (Mark and Stephan, 2019).

Table 3. Typical observed roof fall angles.
Roof Geology Fall Angle (degrees)
Competent siltstone (CMRR>50) 45
Strong shale (CMRR= 40-45) 30
Weak shale/claystone (CMRR=35) 26
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The density of most coal measure sedimentary rock is about 162 lbs per cubic foot.

Secondary Support / Cable Bolts
Lcb = Length of the cable bolts (ft),
Dcb = Diameter of the cable bolts (inches) (may be specified through a drop down
menu),
Cb = Capacity of the cable bolts (tons) (may be specified through a drop down menu
with standard values or manually,
Ncb = Number of bolts per row (entries) or per intersection,
Scb = Spacing between rows of cable bolts (entries only) (ft).

Note1: The two common cable bolt sizes used in the U.S. coal mining industry are 0.6-
and 0.7-inch-diameter, with ultimate tensile capacities of 26.4-and 35.7-tons,
respectively.
Note2: When using metric units the program will only allow the user to specify the cable
bolt capacity (MPa) without reference to the diameter. The user can select a value from
a list or specify a value manually.

Secondary Support / Truss Bolts
Ltb = Length of angled member (ft),
Phi = Truss angle (degrees),
Ctb = Truss capacity (tons),
Stb =Truss spacing (entries only) (ft).

Note 1: Truss angle is typically 45 degrees.
Note 2: Truss capacity is typically the breaking strength (or anchorage capacity) of one
of the angled members.

Secondary Support / Roof Bolts
Lsb = Length of the bolts (ft)
Nsb = Number of bolts per row,
Gsr = Bolt grade (nominal yield strength, ksi) (may be specified through a drop down
menu with standard values or manually),
Dsb = Bolt diameter (inches) (may be specified through a drop down menu with
standard values or manually),
Ssb = Spacing between rows of bolts (entries only) (ft).

Secondary Support / Standing Support
Support Type (drop down menu available),
Css = Capacity per standing support (tons)
Nss = Number of standing supports per row (entries) or per intersection,
Sss = Spacing between rows of standing supports (entries only) (ft).

To calculate the load-bearing capacity of a standing support system, AMRS requires the
capacity of an individual support.  Users may input their own value, but AMRS also
provides a menu of the capacities of some of the most common standing supports. 
Because the load carried by a standing support depends the amount of convergence it
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is subjected to, the values in the menu are the support capacities at two inches of
convergence.  Table 4 below also provides the maximum capacity of each support.

Table 4. Support capacities for different standing support types

Support type

Peak capacity
between 0-2

inches deflection
(tons)

Peak
capacity 

(tons)

4-point Hardwood Crib (8" x 8" timbers, 5' height) 90 158

4-point Hardwood Crib (8" x 8" timbers, 7' height) 74 140

4-point Hardwood Crib (6" x 6" timbers, 5' height) 51 89

4-point Hardwood Crib (6" x 6" timbers, 7' height) 42 79

9-point Hardwood Crib (6" x 6" timbers, 7' height) 94 178

Link-N-Lock (24") 92 150

Link-N-Lock (36") 132 198

Wood Post (6") 22 22

Wood Post (8") 66 66

55-ton ACS Jack 55 55

100-ton ACS Jack 100 100

Propsetter (10") 72 90

Pumpable Crib (24") 135 135

Pumpable Crib (30") 202 202

CAN (24") 95 118

Concrete Crib (24" x 24") 525 525

The data listed in Table 4 was obtained through https://www.cdc.gov/niosh, the National
Institute for Occupational Safety and Health’s Support Technology Optimization Program
(STOP).  The STOP software is used to assist in making engineering decisions
regarding the selection and placement strategy of various standing roof support
technologies.  Additional support types and combinations can be evaluated through a
free download of the STOP software at: 
https://www.cdc.gov/niosh/mining/works/coversheet1819.html 

AMRS compares the rock load height to the secondary support length to check whether
and adequate anchor length is available. Cable bolts should anchor in 3-4 feet of stable
ground above a potential roof fall, while roof bolts need at least 1 foot of anchorage. A
warning prints in the output if the length of the anchor may be inadequate.
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Note: When ultimate strength is used, it is internally converted to yield strength to
perform PSUP calculations. The ultimate strength is used for RDI and PRSUP
calculations.

3.3 Calculations

The suggested sum of the diagonals (SumDg) (Figure 8) is determined using the
equation: 

SumDg (ft)= 46.1 + 0.38 (CMRR)
SumDg (m)= 14.1 + 0.12 (CMRR)

If the actual sum of the diagonals SumD exceeds the suggested sum of the diagonals,
SumDg, a warning is given by the program, but AMRS may still be used.

The suggested Bolt Length, Lbg, is determined using the equation: 

Lbg (ft) = (SumD / 13) * log10(H) * ((100-CMRR)/100)1.5

Lbg (m) = (SumD / 4) *[(0.51+ log10(H))/3.25] * [(((100-CMRR)/100)1.5)/3.25]

where:
SumD = the actual sum of the diagonals (ft or m).

If the actual bolt length is shorter than the suggested length, a warning is given by the
program. If the bolts are more than 2 ft longer than the suggested value, a warning is
also given. A design with very long bolts that have low capacity or are on a wide spacing
may not be successful even if its PSUP appears adequate.

The Actual PSUP (Primary Support Rating index) is determined using the equation
below: 

PSUP = (Lb * Nb * C) / (Sb * We)  (Standard units)
PSUP = (Lb * Nb * C) / (14.5 * Sb * We)  (Metric units)

where:
Lb = the length of the bolt (ft or m),
Nb = the number of bolts per row,
Sb = the spacing between rows of bolts (ft or m), 
We = the entry width (ft or m), and
C = the yield capacity of the bolt (kips or kN).

The bolt capacity (C) is obtained by multiplying the grade of the steel (Gr) (in ksi or MPa)
by the cross-section area of the bolt (in2 or mm2). The bolt capacity needs to be greater
or equal to 8.45 tons to meet ASTM requirements. 
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PSUP is a rough measure of the amount of steel installed in the roof. Its dimensions are
kips/ft or kN/m, but it should be considered an index, rather than a physical parameter. It
does not consider the type of bolt (that is, fully-grouted vs point anchor, tensioned vs
non-tensioned, etc.), because it is difficult to show that one bolt type is superior to
another. Table 5 provides PSUP values calculated for typical primary roof bolting
patterns in US coal mines. 

Table 5.  PSUP values calculated for typical primary roof bolting patterns in US coal
mines. 

Bolt
Length (ft)

Bolt Yield
Capacity (tons)

Entry Width
(ft)

Bolts per
Row

Row
Spacing (ft)

PSUP

4 8.8 20 4 5 2.9

4 8.8 20 4 4 3.5

5 13.3 20 4 4 6.6

6 13.3 18 4 4 8.8

8 13.3 18 4 4 11.8

8 16.6 18 4 3.5 16.8

The support capacity of a single truss (Cst) is calculated as:

Cst = 2 * (Ctb * sin (Phi))

where: 
Ctb = truss capacity, and 
Phi = truss angle.

Figure 13 illustrates the calculation.

AMRS also reports the Reinforcement Density Index (RDI) and PRSUP, two parameters
that are used extensively for roof support design in Australia (Thomas, 2010; Molinda et
al., 2000; Colwell and Frith, 2009). The RDI and PRSUP values are calculated using the
following equations:
 
RDI = 14.5 * (Lb * Nb * CU) / (Sb * We) -- (Standard units)
RDI =  (Lb * Nb * CU) / (Sb *We)   (Metric units)

PRSUP = (Lb * Nb * CU) / (Sb * We) -- (Standard units)
PRSUP = (Lb * Nb * CU) / (14.5 * Sb * We) -- (Metric units)

Where CU = the ultimate (tensile) capacity of the bolt (kips or kN)
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If the user enters the bolt grade (Gr) in Standard units, AMRS converts it to the ultimate
tensile strength of the bolt steel (UTS (ksi)) using the following logic (based on the
minimum values provided in Table 3 of ASTM F432):

UTS (ksi) = (GR * 0.9) + 35 

AMRS uses the following equation to convert the ultimate strength of the bolt steel (CU)
to the yield strength (Gr):

GR (ksi) = (UTS - 35) / 0.9

For cable bolts, the Secondary RDI (SRDI) is given by the equations:
 
SRDI = 14.5 ((Lcb-1) * Ncb * CUcb) / (Scb * We) -- (Standard units)
SRDI = ((Lcb-0.33) * Ncb * CUcb) / (Scb * We) -- (Metric units)
 
where 0.33 m or 1 ft is subtracted from the length of the cable bolt for the “tail.”

The secondary PRSUP for cable bolts is given by the equations:

PRSUPcb = (Lb * Ncb * CUcb) / (Scb * We) -- (Standard units)
PRSUPcb = (Lb * Ncb * CUcb) / (14.5 * Scb * We) -- (Metric units)

The secondary PRSUP uses the primary roof bolt length, rather than the length of the
cable bolts, in the calculation. In addition, 
Ncb = the number of cable bolts per row,
Scb = the spacing between rows of cable bolts (ft or m), 
CUcb = the yield capacity of the cable bolt (kips or kN).

The dimensions of RDI, SRDI and PRSUP are kN/(1000 m)).

3.4 Results Window

Description:

The text is organized in pages. By default, the user views the first output page, which is
usually the second page. The first page is reserved for printing the input data. 

The user may navigate through the text of a single page using the vertical scroll bar and
the arrow keys. No editing is allowed. 

Text can be selected (block select) and copied to the clipboard using Ctrl-C. Use Ctrl-A
to select all text in a page.  

In addition, use the command buttons below for additional output navigation and/or
printing operations:
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Previous Page: Display the previous page of output (if any)

Next Page: Display the previous page of output (if any)

View Plot: Display a plot of the geometry of the mining plan with options to display
dimensions or pillar properties

Print Page: Print current page to any Windows printer.

Print All: Print all pages to any Windows printer.

Copy Page: Copy current page to the clipboard.

Copy All: Copy all pages to the clipboard (pages separated by carriage return
characters).

Generate Graphs:  Generate a number of parametric graphs based on the input data.
For more details see Parametric Graphs.
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4 Parametric Graphs

Description:

The user can create 10 types of parametric graphs: 
· Suggested PSUP vs CMRR
· Suggested PSUP vs Depth of Cover
· Suggested PSUP vs Stability Factor
· Suggested PSUP vs Intersection Span
· Rock Load vs Rock Height (Entries)
· Rock Load vs Entry Width (Entries)
· Rock Load vs Roof Fall Angle (Entries)
· Rock Load vs Rock Height (Intersections)
· Rock Load vs Sum of Diagonals (Intersections)
· Rock Load vs Roof Fall Angle (Intersections)

All graphs are created by by varying the independent parameter around the value
set in the input form.

The figure below shows how suggested PSUP decreases with increasing
CMRR.
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The figure below shows how the suggested PSUP increases with increasing depth of
cover.

The figure below shows how the suggested PSUP increases with increasing stability
factor.
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The figure below shows how the suggested PSUP increases with increasing sum of
diagonals.

The figure below shows how the Rock Load along Entries (tons/ft) increases with
increasing Rock Load Height for the given Entry Width and Roof Fall Angle. The
maximum Rock Load Height value in the graph corresponds to the maximum possible
Rock Load Height for the given Entry Width and Roof Fall Angle.
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The figure below shows how the Rock Load along Entries (tons/ft) increases with
increasing Entry Width for the given Rock Load Height and Roof Fall Angle.

The figure below shows how the Rock Load along Entries (tons/ft) decreases with
decreasing Roof Fall Angle for the given Rock Load Height.
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The figure below shows how the Rock Load along Intersections (tons) increases with
increasing Rock Load Height for the given Sum of Diagonals and a Roof Fall Angle
which is the minimum angle between the Roof Fall Angle for Entries and Crosscuts. 

The figure below shows how the Rock Load along Intersections (tons) increases with
increasing Sum of Diagonals for the given Rock Load Height and a Roof Fall Angle
which is the minimum angle between the Roof Fall Angle for Entries and Crosscuts.
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The figure below shows how the Rock Load along Intersections (tons) decreases with
increasing Sum of Diagonals for the given Rock Load Height and a Roof Fall Angle
which is the minimum angle between the Roof Fall Angle for Entries and Crosscuts.

Note: In parametric graphs that show how rock load varies, when the user input value of
the rock load height exceeds the maximum height (based on the span and the roof fall
angle), then the maximum possible height is used.

See also: Graph Options and The Graph Form

4.1 Graph Options

Description:

The user can set the basic graph formatting parameters as detailed below:

Graph Title
The graph title is a text string placed over the graph.

Graph X-axis Title
The x-axis titles selection includes 10 text fields, one for each type of parametric graph
that can be specified.  These 10 fields correspond to the x-axis titles of the following
graph types:

· Suggested PSUP vs CMRR
· Suggested PSUP vs Depth of Cover
· Suggested PSUP vs Stability Factor
· Suggested PSUP vs Intersection Span
· Rock Load vs Rock Height (Entries)
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· Rock Load vs Entry Width (Entries)
· Rock Load vs Roof Fall Angle (Entries)
· Rock Load vs Rock Height (Intersections)
· Rock Load vs Sum of Diagonals (Intersections)
· Rock Load vs Roof Fall Angle (Intersections)

These text strings are placed below the x-axis of each graph.

Graph Y-axis Title
The y-axis titles selection includes three text fields, one for each group of parametric
graphs that can be specified.  These three fields correspond to the following y-axis
titles:

· Suggested PSUP
· Rock Load (Entries)
· Rock Load (Intersections)

Grid Style
Four grid styles are available: Horizontal lines, vertical lines, horizontal and vertical
lines, no grid lines.

Graph Style
Three graph styles are available: lines, symbols, lines and symbols.

Curve Legend
This option enables or disables the legend box in the graph.

Symbol Size
With this scroll box the user can set the size of the symbols used by the graph object.
The scroll box is enabled only for a graph type of "symbols" or "lines and symbols". 

Default Formatting Parameter Options
There are two options for the basic formatting parameters: 

· To set the formatting parameters (i.e. graph title, x-axis title, etc.) every time the
graph options form is invoked.

· To set the formatting parameters to the ones used in the previous graphing
session. These values are saved in the AMRS.INI file.

See Also: The Graph Form

4.2 The Graph Form

Description:

This form is used to display a graph generated by the calling program.  The menu
options available are:
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File-Print
This option prints the graph to the default printer.

File-Export to Excel
This option exports the data to an Excel spreadsheet.

File-Exit
This option closes the graph form. On some occasions, the option to either keep the
graph or to clear the graph is available.

Edit-Copy
This option copies the graph box to the clipboard for use in other applications.

Edit-Clear Graph
This option clears the graph box from the current graph.

Options-Basic Options
This option loads the graph options form which includes basic graph formatting
options.

Options-Point ID
When this feature is enabled, the graph object will display the coordinates of each point
graphed on the graph form.  Just click on any point of any curve on the graph and the
coordinates of this point will be displayed in the appropriate boxes.  This feature is
active when a graph is displayed. 

Notes:

· Graphics support is provided by Graphics Server 4.53, which is an independent
graph control not included in the Microsoft Visual Basic 6.0 package.

See also: Graph Options,  Parametric Graphs
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5 The Utilities Menu

Settings

Options

Unit Conversions

File Conversion

Clear History Window
This option clears the history (activity) window.

Close/Restore History Window
This option closes or restores the history (activity) window according to the current
window status.

Copy History Window
This option copies the contents of the history window to the clipboard. You can then
paste them to any text handling program for further processing. 

5.1 Settings

Description:

This form is used to define a number of default parameters and settings for the AMRS
program:

Default Units:
This setting controls the default units for a new or blank project file by configuring the
Units field in the Project Description form. Upon entering and accepting project input
parameters, the default setting in the Project Description form cannot be changed. This
setting is saved in the AMRS.INI file.

Default File Extension for Input Files:
This setting is the default 3-letter extension used in the Open and Save dialog boxes in
the File Menu. This setting is saved in the AMRS.INI file.

Data Path:
This setting is the default path used in the Open and Save dialog boxes in the File
Menu.  This setting is saved in the AMRS.INI file.

Show Disclaimer:
This parameter controls whether the disclaimer message will be displayed when
loading the AMRS program. This setting is saved in the AMRS.INI file.

Maximize Main Menu Window:
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This parameter controls whether the main menu window will be maximized when
loading the AMRS  program. This setting is saved in the AMRS.INI file.

Keep Recent Filelist:
This parameter controls whether the program will keep the four (4) recently accessed
data files (opened or saved) as menu items in the File Menu. This setting is saved in
the AMRS.INI file.

Reminder of Annual Updates:
This parameter controls whether the program will display a warning that a year has
elapsed since the last update of the program. The update date is internally stored and it
is not related to the install date. Annual updates ensure that any bugs that have been
discovered are fixed regularly. This setting is saved in the AMRS.INI file.

Display Command History Window:
This parameter controls whether the program will display recently executed commands
(and their resulting actions).  This setting is saved in the AMRS.INI file.

Maximum Characters in Command History Window:
This parameter sets the maximum number of characters displayed in the command
history window, before it is cleared.  This setting is enabled only if the Display
Command History Window option is enabled.  This setting is saved in the AMRS.INI
file.

History Font:
This button sets the type and size of font used in the command history window. This
setting is enabled only if the Display Command History Window option is enabled. 
This setting is saved in the AMRS.INI file.

Enable Toolbar: 
This settings controls whether the program will display a toolbar under the main menu
options or not. The toolbar is not editable. This setting is saved in the AMRS.INI file.

Short Names in Filelist:
This parameter controls whether the program will display the filenames in the recently
accessed list in a short or long format (i.e. including the whole path).  This setting is
saved in the AMRS.INI file.

Load Last Input File:
When this setting is enabled, the program will automatically load the most recently
saved datafile (i.e. the top in the recently accessed files). This setting is saved in the
AMRS.INI file.

Copy Example Files:
When this setting is enabled, the program will automatically copy all example files from
the "Program Files (x86)" directory to the user home directory (i.e.
MyDocuments/MyGroundControl). This procedure runs upon every program invocation
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unless disabled. The modified files will not be overridden, but missing files will be
replaced. This setting is saved in the AMRS.INI file.

External ASCII Viewer:
This option allows the user to specify the external ASCII viewer/editor that will be used
when displaying ASCII data. The default setting in this option is to use the Notepad
editor.  This setting is saved in the AMRS.INI file.

5.1.1 AMRS.INI

Description:

This file is automatically created by the AMRS program the first time it is executed. It
should reside in the default document directory for this program, i.e. in the
MyGroundControl subdirectory of the (My) Documents directory in the computer where
the program is installed (\Documents\MyGroundControl\). Note that in a network
environment the Documents directory may reside on a different hard drive. The INI file
contains entries such as the ones shown below (the sequence and parameter values
may be different in the actual file):

[Settings]
DefaultUnits=0
DisplayActionWin=1
MaxDisplaySize=300
KeepFileNames=1
ShowDisclaim=0
DataPath=C:\Users\User\Documents\MyGroundControl\AMRS\
FileExtension=ARS

[FileMenu]
MaxLastFiles=4
LastFile1=C:\Users\User\Documents\MyGroundControl\AMRS\S1.ARS
LastFile2=C:\Users\User\Documents\MyGroundControl\AMRS\S2.ARS
LastFile3=C:\Users\User\Documents\MyGroundControl\AMRS\S3.ARS
LastFile4=C:\Users\User\Documents\MyGroundControl\AMRS\S4.ARS

[TextBrowse]
BrowseFontName=Courier New
BrowseFontSize=10
BrowseFontBold=0
BrowseFontItalic=0

Note: 

· If this file is deleted, it will be automatically reconstructed the next time the
program is executed but the various settings will default to their original values.
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5.2 Options

Description:

This form is used to define a number of default parameters and settings for the AMRS
program:

Edit / Print Options
Load the Input Form on File Open
If this option is enabled, the input project parameters form will be automatically loaded
in the following situations:

· File - New is selected.
· File - Open is selected and a file is loaded.
· An existing file is loaded from the recent file list.

View Project File in Child Window
If this option is enabled, then the View button in the AMRS parameter entry form will
launch a separate view window with a sketch of the mine plan. The image in this
window can be copied or printed.

Print Module Version Information
If this option is enabled, then whenever the input data are printed, a three-line header is
prepended with the program version, filename, etc.

Create a File Association
Use this option to create an association between the program executable and the
extension of the project files.  Thus, double-clicking on a project file, will invoke the
AMRS program.

Default Parameters (English and Metric)
In this tab default values for a number of parameters are set. The program suggests
default values, but the user may customize the default value menu. Each time a new
project is initialized, the respective fields are loaded with the default values. These
include:

Geology
· Coal Mine Roof Rating (CMRR)
· Depth of Cover (m and ft)

· Unit Weight (lbs/ft3 and kN/m3)
Support
· Stability Factor
· Actual Bolt Length (ft and m)
· Bolt Diameter (in and cm)
· Bolt Grade (bolt yielding strength) (ksi and MPa)
· Ultimate Bolt Strength (ksi and MPa)
· Number of Bolts per Row
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· Row Spacing (ft and m)
Mining Factors
· Actual Intersection Sum of Diagonals  (ft and m)
· Entry Width (ft and m)
Bolt Grade Definitions
The user can enter values for bolt grades in sequence. The default set is 40, 55, 60,
75, 90 and 100 ksi. Default metric strength values (in MPa) are provided as well. 
Bolt UTS Definitions
The user can enter values for bolt Ultimate Tensile Strength in sequence. The
default set is 40, 55, 60, 75, 90, and 100 ksi. Default metric strength values (in
MPa) are provided as well. 
Bolt Diameter Definitions
The user can enter values for bolt diameters in sequence. The default set is 0.625,
0.688, 0.75, 0.804 and 0.875 in (which corresponds to 5/8" rebar, 3/4" rebar, 7/8"
rebar, 3/4" Jbar, 7/8" Jbar). Default metric diameter values (in mm) are provided as
well. 
Cable Bolt Capacity and Diameter Definitions
The user can enter values of cable bolt capacity and diameters. The default set is
0.6" at 26.4 tons and 0.7" at 35.7 tons. These values are correlated so that the first
capacity value corresponds to the first diameter value and so on. Default metric
values (in mm and kN) are provided as well.
Standing Support Type and Capacity
The user can enter/edit values for standing support types and their respective
capacity in tons and kN. 

The figure below shows the default parameters in English (Standard) units. The user can
edit the values and also edit the individual lists for bolt grade and bolt diameter as well
as the grid for cable bolt capacity and diameter. These values will populate the
respective drop down combo boxes under Project Input Parameters. The user can
restore default values by clicking Reset Default.
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The figure below shows the default parameters in Metric units. The user can edit the
values and also edit the individual lists for bolt grade and bolt diameter as well as the
grid for cable bolt capacity and diameter. These values will populate the respective drop
down combo boxes under Project Input Parameters. The user can restore default values
by clicking Reset Default.

The figure below shows the default standing support types and their capacity in tons and
kN. The user can edit the list and add and/or delete support definitions. The user can
restore default values by clicking Reset Default.

5.3 Unit Conversions

Description:

This utility can be used to convert between English and metric units for 4 types of units:
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Pressure
Conversion between psi (pounds per square inch), Pa (Pascals) and MPa
(MegaPascals) is supported.

Length
Conversion between feet, inches, meters and centimeters is supported.

Stress (Pressure) Gradient
Conversion between psi/ft (psi per foot), psi/in (psi per inch), MPa/m (MegaPascal per
meter) and Pa/m (Pascal per meter) is supported.

Load Gradient
Conversion between lbs/ft (pounds per foot), lbs/in (pounds per inch), kN/m (kiloNewton
per meter) and MN/m (MegaNewton per meter) is supported.

Notes:

· 1 Pa = 1 Newton per square meter
· 1 psi = 1 pound per square inch

5.4 File Conversion

Description:

This utility can be used to convert the current file to a different set of units. If the file is
in English units, then it can only be converted to metric and vice versa.

Notes:

· The current file should already be saved before accessing the conversion option.
· After conversion, the converted file becomes the current file.
· A prefix is added to the name of the converted file.
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6 The Help Menu

Use the Help menu option to access the following topics:

About AMRS

Disclaimer

Program updates

References

Resource Files

6.1 About AMRS

The "Analysis of Mine Roof Support" (AMRS) program program was developed by Dr.
Christopher Mark. 

This Windows implementation (version 1.0) was developed by Dr. Zach Agioutantis,
University of Kentucky. 

The help and support of Dr. Christopher Mark and Mr. Ryan Stephan during all stages of
this project is greatly appreciated.

The authors would like to thank J.H Fletcher and Co for the photograph used on the
cover of the manual and on the main program screen.

6.2 Disclaimer

This software is provided 'AS IS' without warranty of any kind including express or
implied warranties of merchantability or fitness for a particular purpose. By acceptance
and use of this software, which is conveyed to the user without consideration by the
developers, the user expressly waives any and all claims for damage and/or suits for
personal injury or property damage resulting from any direct, indirect, incidental, special
or consequential damages, or damages for loss of profits, revenue, data or property
use, incurred by the user or any third party, whether in an action in contract or tort, arising
from access to, or use of, this software in whole or in part. 

See also: Program Updates

6.3 Program Updates

The AMRS program features an automatic update mechanism.  Each time the AMRS
program is executed and the computer is connected to the internet, AMRS automatically
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checks whether a new release is available. The user is then asked whether to download
and install the new release.  

Users may opt out of the automatic program updates (not recommended).  

Users may manually check whether there are updates available that can be downloaded
and installed by clicking on Check for Updates on the form below. 

The AMRS program was officially released in June 2020. Minor updates may be issued
periodically. 

AMRS can also be downloaded from the www.minegroundcontrol.com website. 

6.4 Resource Files

A number of resource files is distributed with the AMRS program. 
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The user can access these files by clicking on the respective command button.
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7 Background Information

Roof Support Mechanics

Roof Fall Database

Statistical Analysis

Design of Supplemental (Secondary) Support

Additional Factors to Consider

7.1 Roof Support Mechanics

Roof support design begins with an understanding of how roof bolts support the ground.
 As illustrated in Figure 4, roof bolts work in several different modes depending on (1)
the strength of the roof and (2) the magnitude of the stress in the ground (Mark, 2000).

Suspension and Skin Control: When the immediate roof is a thick, competent
sandstone or limestone, roof falls above the bolt anchorage are very rare.  Under these
conditions, roof bolts still serve the essential purpose of preventing “skin” failures
involving thin slabs or blocks of loose rock.  Roof bolts also work in suspension when a
thin, weak, immediate roof can be suspended from an overlying strong unit (Figure 2).

Beam Building: When no strong, stable unit is within reach, then the bolts attempt to
create a “beam.” The bolts tie the roof together by maintaining friction on bedding
planes, keying together blocks of fractured rock and controlling the dilation of failed roof
layers. Stronger, stiffer beams are built with longer bolts, larger diameter bolts, and
increased grout length.  The density of the support system can also be increased by
adding additional bolts to the pattern or reducing the row spacing (Figure 3).

Supplemental (Secondary) Support: Supplemental support is required where the
roof is so weak, relative to the ground stresses, that roof bolts alone are not able to
prevent roof failure from progressing above the anchorage horizon. In these cases,
cable bolts, cable trusses, or standing support carry the dead-weight load of the broken
roof, and the roof bolts act primarily to prevent unraveling of the immediate roof. 
Secondary support is typically planned in advance (and may be installed after initial
development), while supplemental support is installed as needed. The terms are
sometimes used interchangeably. The AMRS secondary support module can be used
for either.

7.2 Roof Fall Database

During the late 1990’s NIOSH constructed a roof fall database from 37 coal mines
located in all the major US coalfields.  The database covered more than 1500 miles of
drivage and included 900 roof falls (Molinda et al., 2000).  Underground surveys yielded
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more than 100 “case histories,” each one of which was a portion of a mine defined by its
unique geology, depth, roof span, and roof support (Figure 1).  For each case history,
NIOSH calculated the number of reportable roof falls, the total mining drivage, and the
total number of intersections.  To ensure comparability across the data, only roof falls
occurring within 18 months of development were considered.  Roof falls influenced by
abutment loads due to mining activity, such as longwall retreat or multiple seam
interactions, were also excluded from the data base, as were those associated with
large scale geologic discontinuities like faults or sandstone channel margins.  NIOSH
expanded the data base during the 2000’s to include another 800 miles of mining
drivage and 600 roof falls from another 12 mines known for weak roof conditions.

NIOSH used the original database to develop the Analysis of Roof Bolt Stability (ARBS)
(Mark et al., 2001).  ARBS suggested a level of roof support based on the depth of
cover and the roof quality.  Suggestions regarding the intersection span and the bolt
length were also derived from the data.  ARBS was developed before cable bolts came
into wide use, however, so it was not suitable for weak roof/high stress applications. 
Roof fall rates were also much higher 20 years ago than they are today, so the ARBS
suggested Stability Factor (SF) of 1.2 also needs to be updated. 

Each of the case histories in the NIOSH database was defined by four descriptive
parameters:  Stress level, roof rock quality, roof span, and roof support density. The final
parameter was the outcome.  NIOSH used the number of roof falls per 10,000 feet of
drivage to determine whether a case history was successful or not (Mark et al., 2001). 
The current study focusses on intersection stability, and the outcome is the number of
four-way intersection roof falls per 1000 intersections developed.  Those case histories
with fewer than two falls per 1000 four-way intersections were considered successful,
while greater roof fall rates were considered unsuccessful.  These new criteria are more
conservative than those used in the NIOSH study, reflecting the large decrease in the
roof fall rate since 2001.

7.3 Statistical Analysis

Statistics are essential to interpreting large, multi-variate ground control data sets.  They
are the tools that science has developed to deal with uncertainty and probability. 
Statistics have helped develop a number of powerful ground control design techniques
that are widely used around the world.  However, it essential to keep in mind that in
ground control, statistical analysis assists engineering judgment; it does not substitute
for it (Mark, 2016).

The first step in a statistical analysis is to explore correlations between variables within
the data set.  In general, when two variables are highly correlated with one another, both
cannot be used in the model.  In the roof fall database, the CMRR is highly correlated
with both the intersection span (see Figure 5) and with the Primary Support Rating index
(PSUP).  It seems that where the roof was weak to start with, the mines had responded
by installing more roof bolts and by narrowing their intersections.  This fact poses
particular problems from a statistics standpoint, because some of the mines with the
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highest roof fall rates also used the most roof support and had the smallest
intersections.

Also note that in any regression analysis, a variable that is used in the model must have
a linear effect on the outcome.  The CMRR’s effect is nonlinear, however, because a 10-
point decrease in the CMRR from 40 to 30 has a much greater effect on roof stability
than a 10-point decrease from 80 to 70.  To address this, the CMRR was “transformed”
into a new variable called LnCMRR20=Ln(CMRR-20).

The first goal of the analysis was to help quantify the boundaries between the three roof
support regimes shown on Figure 4.  Logistic regression (LR) was used to model the
data, because it is the technique of choice when the outcome is binary (like “successful”
and “unsuccessful”).  The LR model that fit the data best was used to derive the following
equation:

LnCMRR20 = 0.277 Ln(H) + 1.64 (5a)

Equation (5a) is shown on Figure 6 as the “Discriminant.”  It minimizes the likelihood of
misclassifications, meaning in this case that a success is about as likely to be
misclassified as a failure. 
 
Figure 6 also shows two other lines that are parallel with the discriminant.  All the cases
above the upper line are successful, so this is the estimated boundary between the
Suspension and the Beam Building regimes:

 LnCMRR20 = 0.277 Ln(H) + 1.87 (5b)

Nearly all the cases below the lower line are unsuccessful.  This therefore seems like a
reasonable lower limit for typical US roof bolting support systems, which is the boundary
between the Beam Building and Supplemental Support regimes:

LnCMRR20 = 0.277 Ln(H) + 1.37 (5c)

Figure 6 can be used to derive a pseudo-discriminant equation that includes PSUP. 
Using the data in Table 4, the level of roof support for the upper line in Figure 6
(equation 5b) corresponds approximately to PSUP=3.  The lower line, equation (5c),
corresponds to approximately PSUP=12.  So for a depth of 600 feet, for example, the
suggested PSUP (PSUPg) =3 when the CMRR=58, and PSUPg=12 when the
CMRR=43.  Connecting these two points and combining the result with equation (5), the
PSUPg for a depth of 600 feet can be related to LnCMRR20 as:

LnCMRR20 = 0.277 Ln(600) – 0.056(PSUPg) + 2.04 (6a)

Equation (6a) can be rearranged to solve for PSUPg at a depth of 600 feet:

PSUPg = 4.95*(Ln(600)) - (17.9*(LnCMRR20)) + 36.4 (6b)
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Figure 7 illustrates equation (6).  To create the figure, the depths of cover in all of the
case histories were normalized to 600 feet, using the (4.95*(Ln(Depth)) factor from
equation 6b.  Figure 7 shows that equation 6 seems to fit the data quite well, separating
the successful case history cases from the unsuccessful ones.

Equation 6b can be generalized to predict PSUPg at any depth.  A span factor is also
included that uses equation (2) to adjust the suggested support, similar to the one
previously used in ARBS (Mark et al., 2001).  The final AMRS equation that suggests
the appropriate level of primary support (PSUPg) is:

PSUPg = SF *  [1+((SumD2 –(SumDg)2)/ (SumDg)2)] * 
[4.95*(Ln(Depth)) – 17.9*(LnCMRR20) + 36.4] (7)

7.4 Design of Supplemental Support

When the rock is too weak and the stress too high, roof bolts alone are unlikely to be
successful in preventing roof falls.  In this “Supplemental Support” regime, the support
should have the capacity to carry the rock load, which is the dead weight of the broken
roof that has potentially separated from the more stable overlying rock mass.  The rock
load can be suspended from the stable portion of the rock mass using intrinsic supports
(such as cable bolts, truss bolts, or roof bolts), or the load can be transmitted to the floor
by standing supports.

The rock load can be calculated from the geometry of a potential roof fall. Different
equations are needed for straight segments (entries and crosscuts) and for
intersections. The calculation considers the span, the thickness of roof to be supported,
and the typical profile of roof falls (Figure 9). When determining the thickness of roof to
be supported, mine-specific historical roof fall heights should be evaluated. In addition,
the design should consider the height of any known separations, the length of the
primary roof support, and the free-length of the cable bolts.
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where
γ = rock unit weight (tons/ft3)
ht = rock load height (ft)
We = entry width (ft)
SumD = sum of diagonals (ft)
θ = roof fall angle from entry (degrees)
α = roof fall angle from crosscut (degrees)

The capacity of a supplemental support system is determined by the capacity of an
individual support and the number of supports in each row or intersection. 

Equation (8) calculates the Stability Factor (SF) comparing the support capacity and the
rock load per unit length of entry:

SF = (n * C) / (Spc * RockLoad
Straights

) (8)

where:  
n = Number of supports in a row
C = Capacity of an individual support (tons)
Spc = Spacing between rows of supports (ft)

Equation (9), for intersections, uses the total number of supports (Nint) that are installed
and the capacity (C) of each support. The rock load is calculated using two roof fall
angles, one perpendicular to the entries, and the other to the crosscuts, as explained
above

SF = (Nint * C) / RockLoad
Intersections

 (9)

where:  
Nint = total number of supports
C = Capacity of an individual support (tons)



ANALYSIS OF MINE ROOF SUPPORT50

7.5 Additional Factors to Consider

Providing for adequate support system capacity addresses only one mode of failure,
however.  In general, the design of intrinsic roof support systems must consider five
potential failure modes (Figure 12): 

1. Unravelling of the rock mass between the bolts.  Localized loose rock between
the bolts creates a skin control hazard, and more widespread failure can cause the
heads of the bolts to lose contact with the roof.  Such failure can progress upward to
defeat the entire support system.  Unravelling is prevented with surface control, which
can include straps, surface control pans, mesh, shotcrete, or similar devices. In
general, roof support products that provide greater surface coverage result in better
confinement and reduce unravelling roof failures.

2. Head/plate failure.  Bolt head failure is very unusual, though not unheard of.  Roof
bolt manufacturing specifications address this by requiring that the capacity of the
bolt head exceed the capacity of the rod.

3. Bar failure.  Calculations comparing the rock load to the roof bolt system capacity
are aimed at preventing the bolts from breaking due to excessive applied loads.  Not
only should the tensile capacity of the bar exceed the load, but the bolt’s shear
strength also should be adequate to respond to the potential lateral rock movement.

4. Anchor failure.  Regardless of the type of bolt, some portion of it functions as an
anchor.  A bolt will pull out of the roof when its anchor fails before the bolt breaks.  For
resin grouted rods, typically the upper foot or so serves as the anchor, while for cable
bolts the anchor typically requires three or four feet.  The anchorage capacity should
exceed the design capacity of the bolt, regardless of the type of anchor (mechanical,
resin, or combination).  Effective anchorage is most difficult to achieve in weak rock,
and cable bolt anchorage failures have occurred in the Illinois Basin even with four
feet of grouted length.  Short encapsulation pull tests can be used to check that the
necessary anchorage is being achieved (Mark et al., 2002). The quality of the
installation can also have a large effect on the capacity of the anchor.

5. Length failure.  Length failure occurs when roof failure occurs at or above the bolt’s
anchorage zone.  The length of cable bolts, for example, should allow for adequate
anchorage above the rock fall envelope. Truss bolts achieve this by anchoring in the
stable rock above the pillar, though this is problematic in intersections. 

The stiffness of roof supports is another important consideration.  Stiffness may be
defined as the amount of ground movement that must occur in order to generate
resisting loads from the support.  The stiffness of standing supports in particular varies
considerably between different types of support.  Indeed, the load-bearing capacity of a
standing support cannot really be defined without also specifying the expected
convergence.  Cable bolts are also less stiff than solid bar bolts, because the design of
the strands, the length of the ungrouted portion, and the overall length all allow cable
bolts to stretch more in response to the same applied load. Cable bolts are an inherently
soft support system, which makes them suitable for suspending a rock load from stable
ground.
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Mark, 2000) 
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8.5 Figure 5

Figure 5: Correlation between measured intersection diagonals and the CMRR in the
expanded data base (excluding cases where CMRR>70 or the roof fall rate was
exceptionally high). 
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8.6 Figure 6

Figure 6: The roof bolt support case histories, showing the discriminant equation and
the estimated boundaries between the three roof support regimes. 
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8.7 Figure 7

Figure 7: Suggested PSUP for depth of cover = 600 feet.  The solid gold line extends
covers the range of PSUP from 3 to 12.
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8.8 Figure 8

Figure 8: Sum of the Diagonals or Intersection Span
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8.9 Figure 9

Figure 9a: Estimation of rock load to be carried by secondary support (1/2)

Figure 9b: Estimation of rock load to be carried by secondary support (2/2)
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8.10 Figure 10

Figure 10: Comparison between PSUP values suggested by AMRS and ARBS
(SF=1.5)
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8.11 Figure 11

Figure 11: Capacity of the Roof Bolt
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8.12 Figure 12

Figure 12: Roof bolt failure modes. (1) Unravelling (2) Head/Plate (3) Bar (4) Anchor (5)
Length

8.13 Figure 13

Figure 13: Calculation of the support capacity of a roof truss.
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